Pyramix 7.0 Release Notes
Installation
Please consult the Installation Guide located on the Pyramix Installation Media (CD/DVDROM or USB Memory card) for details of the hardware and software installation procedure
and Authorization Key registration process.
To install the Mykerinos board, TURN YOUR COMPUTER OFF (shut down then switch the
power off). Next plug the Mykerinos board into one of the PCI/PCI-Express bus slots on your
computer and turn the power back on.

Additional installation step for multi-board application
In order to enable multi-board operation, all Mykerinos cards in your PC have to be
connected together using a special HDTDM ribbon cable. This cable has to be plugged into
the multi-pin connectors located on the top edge of the I/O daughter cards. Please contact
your Merging Technologies Sales Partner for information on how to order this HDTDM ribbon
cable.
•
•

To install the Pyramix Virtual Studio software insert the Pyramix Virtual Studio
Installation Media - the installation program should auto-start.
To install MassCore launch the MT Security Settings, go to the MassCore page and
install the MassCore RunTime (a MassCore base key is required).

Updates
Please check our Web site http://www.merging.com periodically for information, patches
and updates.
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Pyramix V7.0 SP3 Release Notes
Pyramix v7.0 SP3 Install Procedure
Additional details on the System Requirements available in the Pyramix V7 Installation Guide.

STEP 1:
Pyramix v7.0 is compatible with the following OS
 Windows 7 Professional (32bit)
 Windows Vista Business (32bit)
 Windows XP with SP3 Mandatory (32bit)

STEP 2:
Users that are running Pyramix v7.0 SP2 can upgrade to Pyramix v7.0 SP3, but Merging recommends
that you remove the present version, from the Windows Add/Remove Programs. Then reboot and
install the Pyramix v7.0SP3.
Users that are running Pyramix v6.2x Merging strongly recommends that you remove the currently
installed Pyramix version prior to installing Pyramix v7.0.
Prior to installing the Pyramix 7.0 version, we recommend that you also back up your Projects and
save your settings, keyboard shortcuts, templates, etc.
1. Go to Windows Control Panel
2. Select “Add or Remove Programs” (XP) / “Programs and Features” (Vista & Windows 7)
3. Remove the installed Pyramix version (Pyramix 5.X or 6.2.X versions) and Reboot

STEP 3:
- MassCore users with having version Pyramix 7.0 SP2 installed can ignore Step 3.
- MassCore users with having version Pyramix 7.0 SP1 installed or older must remove the present
MassCore runtime
How to remove the MassCore runtime:
1. From the Control Panel access the Windows “Add or Remove Programs” (XP) / “Programs
and Features” (Vista & Windows 7)
2. Select "Interval Zero RTX runtime" and Remove it
3. Make sure that you perform a Reboot afterwards.

STEP 4:
Install Pyramix 7.0 SP3
1. Run the Pyramix 7.0 SP3 installer
2. If asked to install Uncertified Microsoft Drivers please continue and confirm the install
authorization (do not use Wizard automatic detection).
3. Reboot your System

STEP 5:
Enter your V7.0 keys
1. Launch MT Security Settings from Windows Start>Control Panel>MT Security Settings
2. Enter your Pyramix v7.0 Keys

STEP 6:
Users that have to install MassCore will have to install the new MassCore Runtime
1. In MT Security Settings go to the MassCore Tab and install the
MassCore Runtime
2. Close MT Security
3. Reboot your system
4. Select the “MassCore” boot entry line at Windows Start Up

STEP 7:
For users with Pyramix and VCube installed on the same system, it is mandatory that you upgrade to
VCube 3.0 SP3 to go along side this Pyramix v7.0 SP3
Note: A MTCleanUp utility is available through Merging’s Support for those having install problems
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Improvements


Album Publishing:
 Robustness



Final Check improvements:
 Latest recommendation for EBU R128
 Improved True Peak filtering



VST plug-ins robustness:
 Mapping improvement with Third Party VST plug-ins for better stability



Record Dubbing robustness:
 Improvements for better stability
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BUGS FIXED Pyramix v7.0 SP3















































(some fixed bugs could be missing from the list)

Fixed: VST plus-ins mapping issue
Fixed: MassCore peak at play start
MT4146: Fixed. Project SRC clips vs. Render causes offset
MT3785: Fixed. First Strip Tools in display might be corrupted on Win7
MT4191: Fixed. MTUSBSync Biphase 25/25 not always working
MT4272: Fixed. Cursor disappears if clicking while mouse scrubbing
MT4283: Fixed. Autoset varispeed sonic quality, since it can cause MassCore overloads
(A registry key is available through Support in order to return to the old behavior)
MT4268: Fixed. Automation: Snapshots & Copy can cause wrong interpretations (phase inverted)
MT4262: Fixed. Automation: Auto-Release will not return to position if not points in curve are present past
the release position
MT4261: Fixed. Automation: Tracks not initialized (without automation point) will not follow VCA
automation
MT4160: Fixed. PureNotes : V7 keys not recognized (Contact Merging support for latest Pure Notes
installer)
MT4258: Fixed. Play selection (and some special playback including an autostop) produce a timeout when
stopping
MT4255: Fixed. Media Browser playback might crash when quickly listening files located in different
folders
MT4249: Fixed. Audition Pre: Cursor not returning at the same location, drifting short
MT4229; Fixed. MassCore: RTX process keeps running when Pyramix crashes and can generates noise
MT4140: Fixed. AAF import: Some files paths are being asked multiple time though Media is present.
MT4270: Fixed. Redithering update in Media Manager SRC dialog.
MT3377: Fixed. Clip Properties "File Creation Date" wrong
MT4254: Recording issues fixed
 Potential crash fixed. In Record when in Dubbing mode
 Potential crash fixed. In stop Record dubbing mode
 Potential Record issue vs. Media Manager update, conflicting
MT4236: Automation curves corruption when displaying and using writing VCA slave faders
MT4209: DiscWrite : CD text info disappear after edit
MT4202: Fixed. FCM : integrating loudness gate issue
MT4248: Fixed. VoiCode is not able to find the CRT dll at runtime.
MT4250: Fixed. PCM1630 import not working in Pyramix 7
MT4196: Fixed. SRC: Audible clicks in SRC Very High Hepta mode
MT4198: Fixed. SRC: Realtime Playback can randomly hang Pyramix (runtime error)
MT4224: Fixed. PMX does not ask to save when closing certain project with X icon
MT3837: Fixed. small glitch at start playback in Timeline and Trimmer
MT4053: Fixed. EDL & CD Tab: Selecting some fields does not highlights them correctly and could hang
Pyramix
MT4169: Fixed. Automation: Mixer Automation state change should rejoin the curve display
MT4179: Fixed. Media Manager: Refreshing a folder will set focus to wrong folder after the refresh
MT4189: Fixed. Media Manager: Playback after Mixdown does not always play the proper audio clip in
trimmer
MT4199: Fixed. search result: doesn't collect search result media when duplicated media is in the
selection
MT4200: Fixed. Album Publishing: Potential hang at AP generation with default settings and certain
images.
MT4205: Fixed. Album Publishing: Crash/Hang when editing the Description field
MT4210; Fixed. Convert: Fail on some project/medias conversion (consolidate)
MT4217: Fixed. Media Manager Reverse creates multiple files
MT4218: Fixed. Wrong message (Low Memory) when trying to auto-save a missing project
MT4219: Fixed. Import : crash if Media Manager is displaying the destination folder
MT4222: Fixed. Jog with a chase machine lags
MT4226: Fixed. AAF Embedded extracted Media disappears after being created
MT4231: Fixed. EDL tab: cannot select clip range with Shift under Windows 7
MT4233: Fixed. Media Manager: Cannot delete media files or crash after an Interchange import (OMF-PMF
files)
MT4234: Fixed. Automation Curves corrupted after EDL reconform
MT4239: Fixed. Automation XML export does not work anymore
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Pyramix V7.0 (SP3) Known Issues
(Some issues could be missing from this list)



MassCore













Now supported under Windows 7 (32 Bit only) since Pyramix v7.0. Note that Pyramix is not
supported under 64bit OS.
Users upgrading from Vista or XP to Windows 7 must uninstall RTX Interval Zero Runtime prior to
upgrading (from Windows Add or Remove Programs). Merging recommends that you proceed with
a fresh OS install rather than Upgrade. See installation procedure at beginning of Release Notes.
Hyperthreading is supported for MultiCore processors only, since Pyramix V6.1, but Merging
recommends that you disable the Hyperthreading for the moment.
We recommend that you do not use more than 65-70% of the Core resources, to avoid intense
graphic refresh burst related problems. Three safe core zones have been set. Eventually this will
be optimized further.
•
0% to 65% Green zone (best performance)
•
65% to 75% Orange zone (moderate risk)
•
75% to100% Red zone (performance could be at risk if major screen redraws are initiated
by the user).
If the Core indicator blinks (red), this will indicate a drop, only be concerned if the drop occurred
during Playback/Mix down or record. To reset the Core drop simply do a Mouse click on the Core
indicator, for more information please refer to the appropriate section in the User Manual. VST
plug-ins users should consult the VST Core Load information also available in the User Manual.
External Insert plug-ins: The same input and output cannot be used in the External Insert plug-in
and the Mixer at the same time, they are exclusive to either one.
MassCore: Core indicator will show a peak/overload after a save on large project or when
rebuilding the Mixer (project open-close). Known as issue MT3113.
Since MassCore is a Realtime engine users should mainly be concerned if the core peak shows up
during realtime events (Play, Record, and Mixdown). To reset a Core peak simply click on the Core
indicator.
The MADI 1 daughterboard is not supported in multi-board, neither in Mykerinos nor MassCore.

General Known Issues


Windows XP user: Windows XP-SP3 must be installed in order to install Pyramix v7.0.



With the Release of version 7.0, new Pyramix systems will only be available in either Native or
MassCore versions. Mykerinos Technology will continue to be used as I/O, but the DSP mixing
power on the cards officially becomes legacy technology. It has been a good run for the Tri-Media
Chips, whose life span has by now extended over more than 11 years, but it is time that we put
them out to pasture. This doesn’t mean that your Mykerinos Based systems will become obsolete
as you can upgrade any Mykerinos system to MassCore without having to do anything but
purchase a MassCore License *. And if you aren’t still sure that you want/need to upgrade, then
the Mykerinos based DSP will still happily work in Version 7 on an “as is” basis.
* please consult the recommended minimum PC requirements for MassCore at
http://www.merging.com/pages/pcconfig



Pyramix 7.0 projects are NOT compatible with the previous Pyramix Releases. In order to open
such projects in an older Pyramix version please make sure that you perform the proper Save
Special option. A Save Special “Save as Version 6.2” was added to the list.
Warning: v7.0 Libraries format are not compatible with the previous Pyramix release. Save as
previous version format will not be possible. A back up of the libraries .pml.6xx file should be
available and can be renamed as .pml in order to be opened in an older Pyramix version (but will
not take in considerations the modifications made to the libraries under the use of Pyramix v7).



Pyramix Native: The Direct Sound mode is no longer supported. We recommend to instead
download and install the Asio4All driver (http://www.asio4all.com/)
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The Virtual Tracks were removed from Pyramix 7.0. It is no longer possible for users to create
them. Note that they are still supported when coming from older projects. As a replacement we
recommend the use of the Automation Sub-Tracks from now on.



Libraries: Search Results created with the 7.0SP1 version have been corrupted due to an internal
bug. You need to purge all search results created with version SP1 either by completely deleting
the Search_Results_.pml file OR by deleting the corresponding folders in the search result view



Changing project sampling rate 1FS/DSD/DXD within the same Pyramix session can at times
cause problems (Mixer stuck at wrong sampling rate). Workaround: launch back Pyramix.



Final Check Metering: When running MassCore on more than one core, it is possible (though not
always the case) that Final Check cannot monitor certain bus/stem (No metering, but it works
again when selecting another bus)
•
Workaround 1: Do not use final check with more than one core.
•
Workaround 2: Add an effect (any effect will do, but you may prefer to pick one that
doesn’t modify the sound: phase oscillo, surround monitor…) on the bus that final
check doesn’t want to monitor.



Low Memory Condition Warning:
A warning informs users when the system is reaching Low Memory Conditions. In order to
save a project under such conditions Pyramix will switch to Save to Disk mode as not enough
memory might be available otherwise. This warning was added in order to prevent a Runtime
Error on Save.
Note that the Save time in Save to Disk mode in Low Memory Condition might take a longer
time since the memory is being dumped to disk in order to allow the users to save their
projects. We recommend afterwards to exit and restart Pyramix in order to free all memory.
This Low Memory warning threshold can be adjusted by the user if one wishes it to come
earlier or later. With every systems and workflows being different, Merging leave you the
ability to adjust when the Warning will show up.
Procedure:
•
Close Pyramix
•
Type regedt32 in the run command
•
In the registry go to HKEY_CURRENT_USER\Software\Merging
Technologies\Pyramix\Settings\Save to disk threshold (this key will only appear if at
least one save was made using that version)
•
Default value in Decimal mode has been set to 15
- The higher the value is set, the earlier the Low Memory warning will come
- The lower the value is set, the riskier it is for you to encounter a Runtime Error at
save (previous Pyramix versions value would have had this value set to 0)
Merging with this Pyramix v7.0 version has significantly reduced the memory consumption of
Pyramix when confronted with the task of loading enormous libraries. For the long term, the
move of our applications to a 64 bit operating system will provide a very solid platform to
accommodate the ever growing project size requirements of some of our users.



MT-USBSync install problems: Use the latest driver in Merging’s Support Download section.



Cannot use DiscWrite with Pyramix:
Workaround: Re-install Pyramix (maybe run clean up after un-installing Pyramix) or Re-install the
Gear driver. Prior to re-installing such drivers use the Gear Removal Utility below.
Gear Removal Utility:
http://www.gearsoftware.com/downloads.php?dir=updates/windows/drivers/&file=Driver_Remover.exe

Find other Gear links that may be useful to determine if the drivers are installed and functioning
correctly and other tips: Gear Driver Status:
http://www.gearsoftware.com/wiki/index.php?title=Determining_if_GEARAspi_drivers_are_installed_correctly

Gear Known Issues:
http://www.gearsoftware.com/rss/GEAR-drivers-feed.php
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Various Known Issues
















Record: A small pause can occur after the first recording of a session. (MT3827)
Timeline and Realtime Sampling Rate Conversion: clicks may occur when doing playback or
mixdown in a region where 2 overlapping clips reference the same media with different sampling
rate than project.
Workaround: Convert those Medias to the project's sampling rate, prior to using such a workflow
MT Asio Bridge not working with some third party applications (e.g. Reason) (MT3596)
StripTools: not always opened from "Fx" track Header. (MT3764)
Workaround: Scroll through the StripTools display once
Recording: Red recording block can disappears during recording on some configuration.
Note: The media will not be affected by this display problem. (MT3577)
Virtual Transport: VT missing Icons for DSplayer and Midi Sync clients. (MT3480)
GPI/O need more time to receive command – less responsive (MT3593)
Workaround a previous dll version can be used, contact support@merging.com
Ogg files with SRC on can make Pyramix crash under Windows XP (MT3569)
Workaround: disable Real Time Sampling Rate Conversion
(Settings>Application>Playback/Record) or convert file
ADR keyboard is by default disabled. To enable it you must download and run the proper Registry
Key. http://download.merging.com/beta/AssociatedTools/ADRKeyboard.zip
Multiple projects opened simultaneously: We do not recommend users to have more than 8
project opened at the same time (due to GDI object limitation).
Waveforms: Since Pyramix V6.1 the new waveform file format is PK2, such a PK2 waveform file
cannot be read in previous Pyramix version and in such a case waveforms will have to be regenerated. On the other side previous waveforms format PK files (Pyramix V6.0 and older) are
compatible with Pyramix V6.1 & V6.2 & V7.0.
The Render Tool will create a temp file for the CEDAR and Nova v0.99 in C:\ Be aware that
Merging cannot change the Temp file patch of such third party Render.
Interchange: AAF non-embedded export to Pro Tools 7x could generate « Could not complete your
request because an unexpected error happened while trying to find an audio media file’s format”
error. We recommend to use AAF Embedded when exporting to ProTools 7. ProTools 8 is known to
be working in such case.



Third Party Plug-ins
 Algorithmix ReNOVAtor for Pyramix: We recommend users to download the latest version available
on their site. www.algorithmix.com
 Cedar: Install issue on certain Vista configurations where you might not see the Cedar plug-ins
after the installation process. The problem is due to erroneous referencing of the license manager
utility on a vista machine. Please contact Merging Support or Cedar Support for all details and
workaround.
 Cedar: Some toolbar icons might be missing if on a Windows XP system. Workaround: Disable the
Skin option in Pyramix>settings>Desktop Layout.
 Altiverb: We recommend users to download the latest version available on the Audio Ease site.
 UAD2: Certified as working with Pyramix, see forum known issues
http://forum.merging.com/viewtopic.php?f=26&t=6798



MP3, AC3 Files and other compressed formats support:
 Default Windows installation should handle most of the common compressed file formats. In case
of problem with the default Widows Installation, Merging has a list of recommended third-party
codecs but will not certify any codecs. http://forum.merging.com/viewtopic.php?f=18&t=5755
 Vista users warning: UAC (User Account Control) can be blocking the “Essentials Codec Pack” at
startup. If this is the case, you should see once logged into your session at the windows bottom
bar a “Windows has blocked some programs” message. You can then unblock it from there or
deactivate UAC from the Windows Control Panel.
 Install the latest Flac distribution certified in Program Files/FLAC, see download link below
http://sourceforge.net/projects/flac/files/flac-win/flac-1.2.1-win/flac-1.2.1b.exe/download
Pyramix will use this distribution to decompress all .flac files
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Pyramix V7.0 SP2 Release Notes
Pyramix v7.0 SP2 Install Procedure
Additional details on the System Requirements are available in the Pyramix V7 Installation
Guide.

STEP 1:
Pyramix v7.0 is compatible with the following OS
 Windows 7 Professional (32bit)
 Windows Vista Business (32bit)
 Windows XP with SP3 Mandatory (32bit)

STEP 2:
Users that are running Pyramix v7.0 (or v7.0 SP1) can upgrade to Pyramix v7.0SP2.
But all MassCore users will need install the new MassCore runtime. See step 3.
Users that are running Pyramix v6.2x can perform an upgrade to Pyramix v7.0 but Merging strongly
recommends that you remove the currently installed Pyramix version prior to installing Pyramix v7.0.
Prior to installing the Pyramix 7.0 version, we recommend that you back up your Projects and save
your settings, keyboard shortcuts, templates, etc..
1. Go to Windows Control Panel
2. Select “Add or Remove Programs” (XP) / “Programs and Features” (Vista & Windows 7)
3. Remove the installed Pyramix version (Pyramix 5.X or 6.2.X versions)
4. Reboot your system afterwards

STEP 3:
All MassCore users must remove the present MassCore runtime since the v7.0SP2 includes a new one.
4. From the Control Panel access the Windows “Add or Remove Programs” (XP) / “Programs
and Features” (Vista & Windows 7)
5. Select "Interval Zero RTX runtime" and Remove it
6. Make sure that you perform a Reboot afterwards.

STEP 4:
Install Pyramix 7.0 SP2
1. Run the Pyramix 7.0 SP2 installer
2. If asked to install Uncertified Microsoft Drivers please continue and confirm the install
authorization (do not use Wizard automatic detection).
3. Reboot your System

STEP 5:
Enter your V7.0 keys
1. Launch MT Security Settings from Windows Start>Control Panel>MT Security Settings
2. Enter your Pyramix v7.0 Keys

STEP 6:
All MassCore users will have to install the new MassCore Runtime
1. In MT Security Settings go to the MassCore Tab and install the
MassCore Runtime
2. Close MT Security
3. Reboot your system
4. Select the “MassCore” boot entry line at Windows Start Up

STEP 7:
For users with Pyramix and VCube installed on the same system, it is mandatory that you upgrade to
VCube 3.0 SP2 to go along side this Pyramix v7.0 SP2
Note: A MTCleanUp utility is available through Merging’s Support for those having problems with their
installalation.

www.merging.com/Pyramix

Merging Technologies
Le Verney 4, CH-1070 Puidoux Switzerland
T : +41 21 946 04 44 • F : +41 21 946 04 45

Improvements



New MassCore Runtime
A new MassCore Runtime (RTX) comes with the V7.0SP2. See install procedure (step3 above)



Album Publishing:
 The number of Output formats is now entirely defined by the user, thus allowing having several output
formats using the same audio format (e.g. you can have 2 FLAC output formats, 3 different WAV
output,...)
 SRC support: For each output format, user can specify the sampling rate and wordlength in the “Add
format” dialog
 Album Publishing generation only; A new option is available from the Image Format dropdown, named
“Digital Release”. Selecting such option allows better quality for the Album Publishing formats since it
avoids the eventual 44.1kHz – 16 bit downsampling intermediate step.
 Filenaming and output folder settings are now global to all formats
 New <SampRate> and <Wordlength> tags for filenaming
 Cue file generation for Contiguous audio file is now implemented, and a additional checkbox (disabled
by default) enables UTF8 encoding of this file (CDEx generates CUE files this way, while
ExactAudioCopy uses ASCII/multibyte encoding)
 “Include Pause” checkbox (enabled by default) for One File Per Track files enables CD pause free
exports
 A new checkbox in the Misc settings section enables the generation of an XML which sums up the Disc
information for publishing, as required by Abeille Musique and HDTracks
 DiscWrite now features Album Publishing as a Target, thus enabling the export of audio files from a
DDP folder or a PMI CD Image
 Auto selection of newly Added Output format
 Added ISRC and UPCEAN tags for File Naming
 Note: Published files that could not be written in a specific destination folder will end up by default in
C:\User\<login name>\MyMusic



Final Check improvements:
 As recommended by EBU R128. You can now display three different loudness bargraphs,
differentiated by their integration time.
 “Loudness M” (For EBU mode Momentary, that is, an integration time of 400 ms)
 “Loudness S” (EBU mode Short, int time 3 s).
 Additional customized loudness meter, with any integration time you like (see setup page.)
 All bargraphs (PPM, VU, TP and Loudness) can additionally display a HistoryGraph. This feature can
be enabled via the setup page. The History graph shows the values displayed by the bargraph,
plotted against time.
 The HistoryGraphs options
•
Start : starts the History Graphs.
•
Pause : freezes the History Graph in its current state. Anything occurring while
paused won’t be taken into account by the HG.
•
Reset : clears the HG.
•
Restart : equivalent of clicking Reset, then Start.
 Copy data to clipboard option: Will copy the data of the history graph to your computer’s
clipboard. The data can then be pasted into a spreadsheet (e.g. Excel-file”) Note that this will
erase any data that was previously in your clipboard.
Hint: you may find it useful to pause the HG first, before copying data to clipboard.
 Loudness INT and LRA
 As recommended by EBU R128. This meter displays such information about your mix
 Also available in bargraphs
 Consult the User Manual for more details on the Final Check improvements
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VoiCode improvements
 New GUI layout
 User presets: The user can now save VoiCode presets
 New “Show Panel B” option, which enables a B preset and allows A to B presets morphing.



Waveforms improvements
 Waveforms: Autoscale is now Track based in Timeline and Fade Editor (used to be visible timeline
based, registry key available to return to such mode)



Pyramix Native improvements
 Now Support up to 128 i/o channels at 1FS (depending of pack/keys)

BUGS FIXED Pyramix v7.0 SP2







































(some fixed bugs could be missing from the list)

MT4194: Fixed. Automation can causes Pyramix to Hang when trimming a clip
MT4187: Fixed. Automation: potential crash when disabling Automation Editing and using Undo list
MT4178: Fixed. Check media Manager Integrity cannot be cancelled
MT4185: Fixed. Ghosts VST makes crash when changing the strip automation mode
MT4170: Fixed. DUAL makes PMX crash when changing input from Track Header
MT4172: Fixed. DUAL input names in Track Header corrupted
MT4177: Fixed. Automation : dynamic write before the first point results to a bad automation curve
MT4175: Fixed. Automation editing in curves editing mode : copy-paste not working properly between
different tracks
MT4167: Fixed. Automation: Undo does not retrieve the correct Automation with some projects
MT4168; Fixed. Loop Selection or Fill Selection from Edit menu makes Pyramix crash
MT4166: Fixed. Some mixer controls do not update their automation mode
MT4161: Fixed. Automation: Cut and Ripple followed by Undo will not retrieve proper Automation curve
MT4156: Fade Editor: waveforms auto-scale zoom ratio improvements
MT4155: Fixed. Akai Import/Export broken
MT4145: Fixed. Library: Put in timeline files with .L and .R extension , only one becomes online
MT4149: Fixed. Library: Composition info are wrong and rename is not active
MT4143: Fixed. Automation not always following clip when moving grouped clips
MT3336: Fixed. Monitor - Master out display only L channel after changing output or meter patch in
configure tab
MT4132: Fixed. FCM - LIAR's buttons have unwanted tooltip popups
MT4141: Fixed. OASIS: Setting of plug-in automation from a console does not work correctly
MT4139: Fixed. Tracks rename cannot be done in group (more than 2) from a multiple Track Tab selection
MT4086; Fixed. Markers no longer displayed in Overview tab
MT3950: Fixed. Automation points lost if moving clip not linked to a mixer track
MT3850: Fixed. Waveforms: Autoscale is now Track based in Timeline and Fade Editor(used to be visible
timeline based, registry key available to return to such mode)
MT3809: Fixed. Archive or Save As does not re-zip project .pmx and ,pml files together
MT3640: Fixed. Internal Machine: "Loop Selection" now stop at the present cursor location and will autoreturn to previous stop (only if in Cursor Auto-Return mode0, a registry key is available for old behavior)
MT4138: Fixed. Insert Silence might crash following a reconform project.
MT4134: Fixed. Media Manager: Random Crash when deleting a clip after a Mixdown, Convert or Render
MT4133: DiscWrite: Cannot open PMI files, you get "Parameter Incorrect Message"
MT4123: Fixed. Settings: First Permanently Mounted Folder with a network pass(\\) won’t mount
MT4121: Fixed. Automation: Mixer not following existing automation curve once the control is released
MT4118: Fixed. Clean up Media might crash if performed on folders that include duplicated media files.
MT4117: Fixed. Clean up Project Timeline msg seem to slow down PMX
MT4116: FCM Loudness colour range should be tunable
MT4113: Fixed. Interchange: importing composition containing 1-file-per-track media (Cantar) relinks
only first track.
MT4112: Fixed. Deleting a Clip in the Media manager after a Mixdown give file in used message
MT4108: Fixed. Final Check: PPM Graph shows bad display in color range
MT4107: Fixed. EDL Import: problem to relink some media
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MT4106: Fixed. Mosaic Sony machine not recognized by its own id
MT4105: Fixed. Project Mounted Media Folders: Changes not notified at pmx level. Close won't ask to save
MT4104: Fixed. Project mounted Media Folders/ Add recursive doesn't work
MT4103: Fixed. Basic automation editing in Auto-Ripple mode broken
MT4102: Fixed. Automation trim can crash Pyramix if no timeline selection present
MT4100: Fixed. Automation Pencil: Deleting previous point if writing in reverse
MT4099: Fixed. Automation Write to end not working if its the last point in line
MT4098: Fixed. Automation: Undo not working correctly when duplicating tracks
MT4093: Fixed. Media Manager: Media / Clean Up Media Doesn’t work correctly
MT4091: Fixed. Reconform EDL crashes due to Automation with certain EDLs
MT4090: Fixed. Media Manager : Not mounting subfolders if it does not contains file present in Timeline
MT4089: Fixed. Media Manager : Folder with ' in its name may crash Pyramix
MT4088: Fixed. Media Manager : Paste with Media or Drop not working if source folder not mounted
MT4087: Fixed. Final Check : loudness meter not displayed correctly
MT4085: Fixed. In SonyP2 offset playback syncro mode, loud noise when going to play reverse
MT4070: Fixed. Rewire: Some (Melodyne) do not detect Pyramix as Rewire host
MT4037: Fixed. Media Manager: quick Import. Import folder is not updated when importing media.
MT4008: Fixed. Document Library: the focus switches to the default library when saving project
MT4000: Fixed. Media Manager: Closing and then Opening project always keeps media folders not
reference to the project mounted.
MT3997: Fixed. Copy Media from Timeline to Media Manager or library (paste with media ) not possible
MT3763: Fixed. Crash when starting a connection with Eucon without OASIS software keys
MT3936: Fixed. Strips connected to VCA will reset when no automation is present
MT3827: Fixed. Rendered or Converted Clips do not appear in Media Manager, needs a refresh

* The Pyramix 7.0SP2 known issues are available at the end of the release notes.
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Pyramix V7.0 SP1 Release Notes
New Feature


Album Publishing:
 This new feature is available through the Generate CD Image dialog and, if enabled, will perform
further encoding/audio file export after a CD Image generation succeeded to create additional user
definable audio files.
 The output can be setup through the dialog which pops up when clicking on Export > Album
Publishing’s settings button
 So far, 4 output formats are available:
 FLAC (lossless compression),
 Ogg Vorbis (lossy compression)
 AIFF (uncompressed)
 WAVE (uncompressed)
 For each selected output format, user can choose to generate single contiguous file (one file for the
whole disc) and/or one file per CD track.
 For compressed formats, additional compression settings can be adjusted with a slider.
 For both Single contiguous file and One file per CD Track cases, the file naming can be specified (file
naming convention) and tags (e.g. <TagName>) can be used (information will be retrieved from the
Disc/Track CD-Text info and Track number)
 Once the user has updated the Album Publishing settings according to his/her purpose, he/she can
launch the CD Image generation. Once the Mixdown/PMI CD-Image generation is over, Album
publishing process will start.
The generated files will be placed in the specified paths (folders will be created if needed) and
metadata will be written based on the CD Image TOC + CD Text information, using conventions.

Improvements


Pyramix Busy warning:
 A new Pyramix status window was added at the bottom right of the Pyramix GUI to warn the user
that Pyramix is still operational (white screens/not responding), during large demanding tasks.
 Your might see one of those messages being displayed
 Pyramix Virtual Studio busy (during tasks like: opening project, mount, renders, libraries,…)
 AAF Parser busy (during AAF import task)
 Merging Technologies VS3 busy (during Mixer tasks)
 Merging Technologies Convert busy (during Convert task)
 The small progress bar within the Pyramix status window will progress at different speed. Be aware
that the progress location does not necessarily indicate the remaining busy time.



Automation delay compensation now working on pan controls (MT4046)
 Panning and ON/OFF automation is now compensated according the audio signal path in the mixer,
just like Aux and Subgroups sends knobs.
 Exceptions are: multi mono buses and multi stereo buses panners.



SACD disc builder updated now compatible under Vista and Windows 7 (thus fixing a previous crash during
the Cutting Master generation)



Recording: a new warning was in the Stall Report window
 The message warning is “Your Recording may be at risk”
 If the Destination Media Drive performance is insufficient we detect it and recommend that you
change the destination media drive or optimize it.
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BUGS FIXED Pyramix v7.0 SP1





































(some fixed bugs could be missing from the list)

MT4072: Fixed. Album Publishing: Encoded track files are not accurate, some containing 2 tracks.
MT4064: Fixed. Clip Properties/ selection: Name or Comment field can become un-editable if docked.
MT4069: Fixed. Safe Record: prevent users from changing the track monitoring mode or track input
selector in Safe Record mode.
MT4081: Fixed. Shared Mixer: Crash if selecting the Automation Track display button "A".
MT3955: Fixed. Pyramix in rewire master mode should not display Rewire outputs.
MT4082: Fixed. Multiple Rewire clients installed issue (Only one of them drives audio known as MT4070 as
well).
MT4084: Fixed. VS3 Control panel : Audio Bridge section not always correctly reloaded.
MT4051: Fixed. Generate CD Image may have drops at specific edit locations.
MT3657: Fixed. Remote: EMC controller pan-pot light not stay Lightened when switching banks.
MT4075: Fixed. Mackie MCU fader mapping silkscreen match to be improved.
MT4054: Fixed. New from Template - new workspace : folder not mounted.
MT4031: Fixed. Library: Moving items from a Shelf to another will copy it and not move it.
MT4021: Fixed. Some AVID AAFs are not relinking.
MT3959: Fixed. Settings: Set the default undo value should be 20.
MT4057: Fixed. Make Timecode toolbar slightly larger and easier to see (Only available with registry key,
contact support if needed).
MT4071: Fixed. Automation: Snapshot to cursor with "To end" option will crash Pyramix.
MT4052: Fixed. Automation: Copy from project to another one is inaccurate.
MT4034: Fixed. Switching between projects does not restore the composition window position to
Maximized.
MT3919: Fixed. In playback loop mode, Pyramix and a rewire client drift.
MT4067: Fixed. AAF Import: Some clips have half a waveform.
MT4061: Fixed. Export Report Printer : AbsSource field is always 00:00:00.
MT4057: Fixed. Libraries: cannot open newly created Shelf.
MT4050: Fixed. Auto-save strange file naming.
MT4040: Fixed. Pyramix Crash: when selecting and deleting clips quickly.
MT4035: Fixed. Library: Moving any saved VS3 Preset from the Document Library to the VS3 window
could crash Pyramix.
MT4032: Fixed. Library: Deleting multiple Items from the Library does not delete all of them.
MT4027: Fixed. Library: Cannot use Search the first time an offline library is created.
MT4026: Fixed. Library: Cannot rename properly a Shelf.
MT4022: Fixed. Media Clip delete from Media Manager can be erased from other Folders.
MT4013: Fixed. If Database Drive is removed, PMX will not start.
MT4012: Fixed. Removing StripTool from some specific mixer may crash Pyramix.
MT4007: Fixed. VCA slaved faders bad offset when doing a snapshot.
MT3969: Fixed. Automation Curve update problem when writing automation in Fixed cursor.
MT3849: Fixed. Save to search library can take long time on large Sound FX libraries.
MT3991: Fixed. OMF Import : media folder not mounted after import.
MT2276: Fixed. CD Image: Request for an option so that individual tracks to be created along with the CD
image.
* The Pyramix 7.0SP1 known issues are available at the end of those release notes.
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Pyramix V7 Highlights
Please find below a list of major Pyramix 7 new features and improvements.
More details about new features and improvements in the following pages.
For a complete description and explanation please read the User Manual.

New Features
MassCore™
 Support for Windows 7 (32 bit)
 SMP Multi-core support (optional Key)
New libraries & Media Manager database structure
 Consumes less memory
 New management structure
 New options
 New Column management
New Pyramix GUI
 New Track headers layout
 New Timeline clip display
 New Toolbar items & Display options
New Search Tool
 Fast and efficient
 Search results library & Search History
New SRC with ultimate quality
 Ultimate quality
 64 bits float internal resolution
 Available from Media Manager, CD Generator and Mixdown
New Final Check Loudness Meter (optional)
 Plugin dedicated to precision metering
New VoiCode plug-in (optional)
 Merging's professional Mono to Stereo upmix plug-in
Rewire Support
 Propeller Head “Rewire Mixer Application” support
 Transport, Bars & Beats support through Rewire client and Pyramix
Major Automation Overhaul
 New Automation Sub Tracks
 New Bus Automation Tracks
 New management workflow for Automation tracks
New Bars & Beats Toolbar
 New Bars & Beats counters
 Multiple options and Signature now available
Sony protocol Support over IP
 Pyramix and VCube can now be synchronized through LAN

Improvements
Faster Save - Jog Improvements - Automation & Envelop Improvements - Half Waveforms
display - Libraries Improvements - New Timeline Layout display Settings – Editing
Improvements - Toolbars & Markers improvements - FLAC decoding support - And more
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Pyramix v7.0 Install Procedure
Additional details on the System Requirements are available in the Pyramix V7 Installation
Guide.

STEP 1:
Pyramix v7.0 is compatible with the following OS
 Windows 7 Professional (32bit)
 Windows Vista Business (32bit)
 Windows XP-SP3 (32bit)

STEP 2:
Users that are running Pyramix v7.0 can simply upgrade to Pyramix v7.0SP1.
Users that are running Pyramix v6.2x can perform an upgrade to Pyramix v7.0 but Merging strongly
recommends that you remove the currently installed Pyramix version prior to installing Pyramix v7.0.
Prior to installing the Pyramix 7.0 version, we recommend that you back up your Projects and save
your settings, keyboard shortcuts, templates, etc..
1. Go to Windows Control Panel
2. Select “Add or Remove Programs” (XP) / “Programs and Features” (Vista & Windows 7)
3. Remove the installed Pyramix version (Pyramix 5.X or 6.2.X versions)
4. Reboot your system afterwards

STEP 3:
MassCore users must remove the present MassCore runtime.
7. From the Control Panel access the Windows “Add or Remove Programs” (XP) / “Programs
and Features” (Vista & Windows 7)
8. Select "Interval Zero RTX runtime" and Remove it
9. Make sure that you perform a Reboot afterwards.

STEP 4:
Install Pyramix 7.0
1. Run the Pyramix 7.0 installer
2. If asked to install Uncertified Microsoft Drivers please continue and confirm the install
authorization (do not use Wizard automatic detection).
3. Reboot your System
Warning for Windows XP users: Due to some new installer requirements you will have to update to XPSP3 (with latest updates) in order to install Pyramix v7.0.

STEP 5:
Enter your V7.0 keys
1. Launch MT Security Settings from Windows Start>Control Panel>MT Security Settings
2. Enter your Pyramix v7.0 Keys

STEP 6:
MassCore users will have to install the new MassCore Runtime
1. In MT Security Settings go to the MassCore Tab and install the
MassCore Runtime
2. Close MT Security
3. Reboot your system
4. Select the “MassCore” boot entry line at Windows Start Up

STEP 7:
For users with Pyramix and VCube installed on the same system, it is mandatory that you upgrade to
VCube 3.0 to go along side this Pyramix v7.0
Note: A MTCleanUp utility is available through Merging’s Support for those having problems with their
installalation.
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V7.0 New Features
MassCore support under Windows 7 OS


Note that Pyramix only Supports 32 bit OS (Windows 7 – Vista - Windows XP-SP3)

MassCore multi-core support option






Option only available with MassCore SMP key
The key will enable the VS3 Control Panel option for Core allocation, to enhance the MassCore engine
performance.
Slider allows the user to chose the repartitions of Cores
Merging recommends that you allocate at least 2 Cores for Windows (with Quad Core or i7
configurations).
Current MassCore version allows up to 8 Core allocation

New Libraries




New improved Library structure
 Consume less memory due to new Libraries Database structure (MT3346)
 A default Database Location path can be set under Settings>Application>Location>Default
Database Location. Otherwise the database path will be C:\Documents and Settings\<User
Name>\Application Data\Merging Technologies\Pyramix.
Warning: For better performance we recommend that you move the Database location on
your fastest system Drive (e.g. 7200rpm Disk recommended and not necessarily C:\OS
default drive, as a drive with less activity could be performing better)
 You can clear the History of the Media Manager Database entries from the Media Manager.
Under the menu Media Folder
 Check also that the Fade Library Location is valid: Settings > All Settings > Application
Editing : Fade Library Location
 Libraries from previous releases will be converted at the first opening and we will preserve
the older libraries version as a .pml.6xx file.
 Warning: Library opening will take longer the first time a library is opened under V7.0 due to
the conversion to the new library format
 Warning: Due to the Library format changes if downgrading to a Previous Pyramix version
(e.g. v6.x) the v7.0 Library format will not be compatible. The user will have to rename its
older .pml.6xx files as a .pml in order to re-open the previous backed up libraries.
You cannot save to older library version.
New Columns settings from the Library/Options/Library (MT2284)
 Rearranging Columns:
Columns present in Library, Media Management and Search Results frames can be
rearranged by simply clicking and dragging the column headers.
 Reordering Columns:
Clicking on a column header does two things on Columns where this is appropriate. It orders
all Library entries according to the numerical or alphabetical order of that Column and it
toggles that order between Ascending and Descending
 3 options are available to set columns set:
•
Apply to Folder: Only locally on the current folder.
•
Apply to Library: Apply to all folders ONLY IN CURRENT LIBRARY
•
Set as default: All subsequently folders will be created with this set. (Also apply set to
root).
 With these 3 actions the column sizes are re-adjusted to optimal width and the current folder
display is updated after a change in Options
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New Pyramix GUI layout













New menus:
 View > Scales / ToolBars > Show/Hide All ToolBars
 View > Scales / ToolBars > Show/Hide Bars & Beats Grids (timeline grid only)
 Edit > Automation > Editing (see Automation Revisited Features)
 Monitor > (see Monitor Panel improvement)
Timeline:
 Clips have a gradient texture (can be disabled from settings)
 Tracks separators are also grouped by Strips connection
 Region Selection much smoother
 Clips Handles bigger
 Mouse pointers have been changed to ease the understanding and the grabbing of handles
Transport new GUI revamp layout
 TC Master source can be set by selecting the Master entry, a drop down menu will appear
 Track header i/o list now includes the Physical i/o name
 Set In/Out and Goto In/Out merged into a single In/Out button set
•
Click for GoTo
•
Ctrl + click for Set
Track Headers new GUI layout
 Main/Big Track number removed. The Strip Number is now the Main Number, and the
Channel Type (L,C,R…) is displayed on its right in a grayed color.
 The Display Waveforms Icon was replaced by three states indicators
•
W: Display Waveforms
•
E: Display Envelope
•
T: Display Blocks
 Tracks visually grouped by strip connection
•
When strip grouped, only the first track buttons are visible
•
All other tracks show only the strip channel type (L, C, R, …)
•
Buttons can be shown by clicking the little [+] button
 The Track group reference name the Collapsed and Hidden options were removed from the
Track Header as those options are present in the Track Group or Track Tab.
 New Ctrl + Shift modifiers for all tracks header buttons
•
No modifier, auto-grouped by track group, then by strip
•
Ctrl bypasses any grouping (affects only the clicked track)
•
Shift affects all tracks
•
Ctrl + Shift bypasses the track groups, but still follows the strip (very handy when
multichannel strips/tracks are grouped)
•
User Middle Mouse Wheel to scroll Track height.
 Settings>Application>Track Header Layout customization has been removed
Scales:
 New color scheme
 The current timecode is displayed in the scale header (instead of the range)
 The Markers header shows the currently selected marker
 Clicking in the marker header opens a combo box to go to a marker
 Editing Mode, Master Solo/Mute and Shared Mixer mode have moved to the main Toolbar
(below)
Main Toolbar:
 All counters revamped and aligned horizontally to save space
 Editing Mode, Master Solo/Mute and Shared Mixer mode have moved to the main Toolbar
Tabs new GUI layout
 All Tabs were unified to new GUI layout. Mostly flatten and cleaned up all tabs content
 EDL Text Tab rewritten

www.merging.com/Pyramix

Merging Technologies
Le Verney 4, CH-1070 Puidoux Switzerland
T : +41 21 946 04 44 • F : +41 21 946 04 45

New Search tool








New Quick search tool SQLite based
The Search Tool is available in the toolbars of the Libraries and Media Manager Tabs
Search works in combination of standards *, AND, OR, NOT
Clear Search field by Mouse Clicking on the X field icon
Options are available at library Search menu or with the icons next to Search Field
 Search option allows for searching either in All Mounted Media Folders or recursively in
the selected Media Folder displayed in that frame otherwise.
 Save to Search Results:
•
When clicking button or selecting menu, the currently displayed result of the search
query is copied to the Search Results view (see Search Result view).
•
If the user has made some selection in the displayed result, only this selection is
copied to the Search Result (result subset) when clicking button or selecting menu
 Clear Search History:
•
You can Clear the search requests history from the dropdown search field
Search Results view:
 A Search Results view is now dedicated to store search results. It’s prompted by pressing the
search Icon:
 The results of searches in any of the other Library and View windows can this way be sent to
the Search Results window. Media > Search Media opens the Search Results window.
 The Search Results window behaves just like any other Library / View window. The contents
of saved searches can be searched and selected results added to the Timeline and or to other
Libraries and as new Search Results folders.
 Each time the Save to Search Results option is used, a folder is created in the Search
Results, including date and search request. This folder can be renamed.
 The search box in the Search Results view is different: Instead of searching all libraries in the
frame the Search all option will search the all Media Manager and Global Libraries, while the
search current will sub-search the all Search Results library.

New Sampling Rate Conversion

(SRC)
Available in Generate CD image, Mixdown and in Media Manager
 Ultimate quality
 64 bits float internal resolution
 TPDF dithering with NoiseShaping
 3 different filter impulse response types (Linear, Minimum Phase, Apodizing) to fulfill the various
typical expectations
 HeptaCon Pyramix SRC supports:
 DSD64 input (DSD to DXD conversion)
 44100, 48000, 88200, 96000, 176400, 192000, 352800 and 384000 PCM input and output
sample rates
 Only one quality setting is available (this is why the Quality drop down is locked to Very High)
 8, 16, 18, 20, 24, 28 and 32 bits quantizing
 TPDF NoiseType for dithering (this drop down is locked also, as RPDF is not available)
 2 different NoiseShaping filters
 3 Anti-aliasing Filter Types:
•
Minimum Phase: Design will feature an asymmetric impulse response (minimum
phase response)
•
Linear phase: Feature constant group delay (thanks to the linear phase) has a
symmetric impulse response, but also longer rings
•
Apodizing filter: Offers the steepest response around Nyquist and linear phase,
offering best of both worlds for the about the same computational cost as the 2 other
designs
 SRC is available in the Mixdown and Generate CD image
 Only available in Non-Realtime Mixdown
 Activate the Processing SRC and ReDithering option in order to access the SRC Output
Settings properties
 In the SRC properties you can access
•
Data Format
•
The Sampling Rate Conversion
•
The Dithering setting

www.merging.com/Pyramix

Merging Technologies
Le Verney 4, CH-1070 Puidoux Switzerland
T : +41 21 946 04 44 • F : +41 21 946 04 45

New Final Check Metering option

(multi metering tools)
See User Manual for complete details
Available with the Final Check optional key
General GUI explained (see User Manual for all details):
The Final Check Metering layout is divided between the (upper) stereo-panel and the (lower)
surround-panel. Each panel can be collapsed/expanded using the “-”/“+” button indicator (upper-left
corner of each panel).
To select which Bus/Stem you want to monitor, click on the triangle indicator pointing downwards (top
right corner of each panel). You can then select the bus and, the stem you want to monitor. Note that
the stereo panel allows you to select Downmix of any surround bus/stem as well.
 Short explanation of the meters available on the main metering page. All these meters are fully
customizable via the setup page (decribed below)
1. Phase meter. The color of the indicator changes to red when the correlation falls below zero.
 In surround panel, the little logo displayed additionally shows you which 2 channels are being
monitored. These can be changed via right-click menu or setup page.
2. In stereo panel : PhaseOscillo/PhaseStereoMeter/VUStereoMeter. Available under the Setup
page in order to toggles between the three of them.
In surround panel : Surround meter. Red lines indicate negative phase between two neighbor
channels. Longer red lines indicate phases closer to -1.
3. PPM (white bargraphs) : change the different dynamics and scaling-presets (DIN, Nordic, BBC
or EBU)
4. True Peak Meter (orange bargraphs) : also known as intersample peak meter. This meter
performs an additional over sampling that allows you to spot peaks located between two
samples, and hence to identify areas that are likely to peak after DA conversion.
5. VU-meter (green bargraphs) : a classical VU-meter, with customizable dynamics.
6. PPM, True Peak and VU meter all include a peak hold and overload indicator that you can
separately set up in the setup page. Click on any meter to reset its peaks and overloads
manually. Hit “P” to reset peaks and overloads of all meters
7. Loudness meter:
 Sum of all channels or loudness per channel.
 Fully EBU R-128 compliant. This meter displays a bar-graph as well as the numerical value
LUFS (Loudness unit, Full scale, formerly known as LKFS).
 In the setup page, you can select the time interval upon which you want to integrate
loudness (EBU-short, EBU-momentary or any time you want)
 In the setup page, you can enable a peak hold feature. We enabled, the numerical value will
additionally display the letters “Pk :”, and the number won’t reset until you click on it.
 Loudness Integrating Mode (Int) and Loundess Range (LRA) are effective when you your
measurement is running. You can control this using the 4 “Start”, “Pause”, “Reset” and
“Restart” buttons.
 The value beside the Int and the LRA ones in parenthesis () represents the time during which
we've Integrated. Note that it’ll stop increasing when your signal is below the gate threshold
(which you can define in the setup page) A playback pause will therefore not affect the
MEASURED value. When the signal is gated, the word GATED is displayed as well.
 Additionally, this meter displays a plot against time of its recent sum over all channels value.
This history graph is also piloted by the “Start”, “Pause”, “Reset” and “Restart” buttons.
 Fully compatible with ATSC (Advanced Television Systems Committee) A/85.
 Fully compatible with ITU-R 1770-1.
 LUFS are the same unit as Dolby Dialnorm™ unit, and you will therefore get the same results
as long as Dolby's automatic speech detection is disabled.
 LUFS are exactly the same unit as LKFS. EBU R-128 however prefers the name LUFS.







Setup page :
 Can be accessed simply by clicking the “Setup” button on top right of the window, near the
“x” button for closing the window (note the “Metering” button which allows you to come back
to the main Final Check window.) In the setup page use the “Enable” buttons of each section
allow you to show or hide a given meter. More details to the different controls in user
manual.
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VoiCode Plug-in










Merging's VoiCode Plug-in is the first professional mono to Stereo upmix. Available with optional key
only as a VST plug-in
In order for the VoiCode to be seen within Pyramix, the users will need first launch VST scanner and
scan this folder path ”C:\Program Files\Steinberg\VSTPlugins\Merging Technologies”
Genuine MS virtualization of your sound sources within their natural recording environment. All
possible directivities are supported
Fit for real-time and on the air productions
MS virtualizer showing the range of suitable parameters
Automatic parameter calibration
Manual expert mode for postproduction
Correlation editing features
Correlation meter and Oscilloscope included

Rewire Support







Propeller Head “Rewire Mixer Application” is now supported with Pyramix
The Rewire support must first be enabled in the VS3 Control Panel under the Audio Bridge section
The number of Rewire channels is in relation to the entered value in the VS3 Control Panel
The Rewire connectivity will appear in the Mixer inputs, as lives inputs
Supported from 1FS up to 8FS
Note that you cannot use the combination of Rewire and the Asio Bridge. Only one mode at a time
can be selected in the VS3 Control Panel (such support is planed in a near future).

Major Automation Overhaul


Track Header New Automation Editing Sub-Tracks
 The [+] on the right of the Automation Track Name on the third row of the Track Headers now
opens a new sub-track instead of creating a Virtual Track.
 This sub-track displays the automation curve and shows on the header its name and a little [+]
and [-]
 The [+] allows for opening another sub-track
 The [-] allows for removing this sub-track
 When there’s at least one sub-track a little [A] appears on the left side of the track header
allowing for collapsing/expanding all Automation sub-tracks.
 The check box in The Select Display Automation Track accessible through the dropdown
“More…” menu that was allowing the Create a Virtual Track has been renamed : “Display the
selection in an extra automation sub-track”.



Track Header New Automation Bus Tracks (MT3400)
 Normal Audio Tracks are used for this feature
 When clicking on the Top/Left button for connecting the Track to the Strips, the dropdown menu
now allows to also connect the Tracks to Mixer Bus
 Slight difference however between Strip and Bus tracks channels. For Strips we connect a Track
to a Strip discreet Channel if the Strip is multi-channel, where as for a Bus Automation we
connect the Track to the entire Bus without distinction of its channels.
 The Bus ID is display in the connection Box (SR1, ST2, A3, etc…)
 The Bus Name is display in the Name Box, but is NOT editable (to be implemented later)
 The Fx button remains available
 The Automation button [A] is available
 The Automation Name and [+] are available
 Automation Sub-Tracks (through [+]) are available
Notes:
 When connected to a Bus the Track doesn’t playback any audio while still allowing for
carrying clips
 When right clicking on the [A] button or left clicking on the Automation Name or [+] all
menus allowing for selecting Automation Tracks do filter available tracks following the Bus
controls like it does for Strips when connected to a normal Strip



Track Header New VCA Group Tracks:
 Users can now connect Groups Strips directly from the Track Header

www.merging.com/Pyramix

Merging Technologies
Le Verney 4, CH-1070 Puidoux Switzerland
T : +41 21 946 04 44 • F : +41 21 946 04 45




The VCA Group name identifier is the current VCA Group Name in Mixer

Automation Editing Menu new Global Modes
New entries in the Edit menu under Automation Editing, Global behaviors:
 Enable Automation Editing:
 Enabled By Default
 Allows Timeline Automation editing as said.
 Cut/Copy/Delete Displayed Automation: (delete to be added in next build)
 Will affect all Automation Displayed only when Editing (so only Curves visually showing)
 Cut/Copy/Delete Whole Strip Automation:
 Enabled By Default
 Will affect all Automation, even the ones that are not displayed in timeline track when
editing.
 Erase points on Cut/Delete:
 Will erase all point contained in the selection
 It will not add Automation points to boundaries of the selection
 Delete and Interpolate on Cut/Delete:
 Enabled By Default
 Will interpolate a curve from start of selection to end of selection
 Delete and Maintain on Cut/Delete:
 Will not interpolate the curve from start to end of selection so it maintains a flat curve at Cut
or Delete



Notes:
 Toolbar Buttons are available for those Automation Editing entries.
 The Automation Menu will not take in consideration those modes and can be used
independently to the Automation Editing mode.

 VCA Groups
 VCA Tracks Editing
 The VCA Group Automation is now displayed in the Timeline as a shadow/summation (Gain or
Mute only) to the current Automation of the Strip linked to that VCA Group
You cannot edit the VCA Group Automation when it is displayed in a Strip Track part of that
Group, but all editing of the Strip Automation will Link and calculate the summation in real
time.
 The VCA Group Automation can only be edited if displayed in its own Track Header (see
above)
VCA Coalesce:
If a Strip is associated to a/multiple VCA group when you exit the group you have a Message Box
that will display "Leaving VCA Group" two choices are available
 Coalesce Yes: Will Commit the Strip Automation to the VCA Group Summation
 Coalesce No: Will exclude VCA Group Automation summation and leave Strip Automation
curve as it was.
 Note: The Coalesce Mixer button is the only one in the Mixer supporting Undo/Redo.







Automation options for SnapShot Range By Strip
 All: Always opens selecting All
 Nothing: Always opens without selecting any item
 Displayed: Will auto-select the automation items based on the current displayed Automation
curves in timeline
 Last: Will remember the last selected items*, it can be seen as a sort of preset
 Notes:
 Pressing CTRL and the Snapshot Range Cameras button will automatically apply a snapshot
without opening the Window, doing so by considering the last opened state. Make snapshots
much quickly. You can also use the Automation Menu “Automation SnapShot Range Last
Selection” entry.
 Warning*: Rebuilding the Mixer will re-initialize the Snapshot window selections, since entries
are added or removed (back to default snapshot state)



Automation options for SnapShot Range By Type
This view is a little like the old view by buses, to the difference that we now regroup all the Mixer
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Parameters under a common item. All Gains will or all Mutes will be regrouped under one item (Gain
or Mute)
 Notes:
 If you have multiples Plug-ins they will also be regrouped, but you will see their entries
depending of the insert order position.
 The parameters selection is saved and recalled the next time you want to apply a new
snapshot. This is very useful when you want i.e. snapshot only EQs whatever the timeline
selection.



Automation Snapshot Range Fade option.
 “Fade From”
 New option is available for Snapshots Range only
 It allows you can applied a Fade From or To Selection boundaries
 User can enter the Fade length value in ms
 Note: Fade value before Pyramix version 7 was 0 and not settable
 “Fade To” Option
 New option is available for Snapshots Range only
 The result of a Fade To is applied prior to the selection boundaries



Automation Snapshots Cursor Options

“Maintain to Next Point” option
 This option is by Default unchecked and will perform the snapshot on selected parameters all
the way to the End
 If checked we will perform the Snapshot up to the Next point present on the Automation
curve of the Selected Parameter.
 Automation Snapshots To End option
 Unchecked: This option is by Default unchecked and is available for the Snapshot Range by
Strips only (not available in snapshot range).
 Checked: The snapshot Result will apply the Snapshot all the way to the end
 Notes:
 Pressing CTRL and the Snapshot Cursor Camera button will automatically apply a snapshot
without opening the Window, doing so by considering the last opened state. Make snapshots
much quickly. You can also use the Automation Menu “Automation Snapshot Last Selection”
entry.
 Warning*: Rebuilding the Mixer will re-initialize the Snapshot window selections, since entries
are added or removed (back to default snapshot state)

New Bars & Beat toolbar







Preroll clicks follow the Signature Denominator (x/4, x/8, x/16, etc...)
The Signature is now available in the B&B counters and affects the current Bar under the cursor (as
per the tempo)
By default the preroll beats the denominator, but if the user Clicks on the SG (Signature) label of the
B&B, it will turn to Cyan, this particular Bar Set under the cursor will be considered as Compound,
and the preroll then beats every other 3 denominators.
A Link symbol (chain) between the CLK IN and CLK OUT symbols was added. Clicking on it will toggle
between No Link ( ), Markers (MRK) and Region (RGN). Click In/Out are then automatically linked to
the Markers or Selected Region
A simple Mouse + Click on the Bars & Beat “Metro” name will open the Metronome Settings
Bars & Beats counters include:
 Start Offset for the first Bar
 BPM setting for the first tempo map (the one starting at first Bar)
 A PreRoll in Beats for the Metronome
 A On/Off/PreRoll Only toggle for the Metronome
 A Volume control for the Metronome
 Click In and Click Out counters
 When Click In is set (to something else than 1, 1, 1) the PreRoll pre-counts to Click In
Bar/Beat, otherwise pre-counts to the first Bar
 The BPM counter now shows and allows modifying the tempo map portion where the cursor is
on (and not anymore the first tempo map portion)
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Sony protocol support over IP






Pyramix and VCube can now be synchronized through LAN
Enhanced reliability and simplified configuration (VT server no longer needed)
Machine Support Configuration
 Can be enabled in the Settings>Machine>Sony 9 pin properties, “Pipe (Ethernet)”
 Configure the “Pipe (Ethernet)”
•
Identifying the Remote Computer Name (can be left black if the Remote Computer is
local)
•
The Port Name (can be left blank if only one port is used by the system)
Controller Support Configuration
 Can be enabled in the Settings>Controller>Sony 9 pin properties, “Pipe (Ethernet)”
 Configure the “Pipe (Ethernet)”
•
Configure the Port Name (can be left blank if only one port is used by the system)
 VCube transparent to configuration
•
No special Settings needed (no Port Name field)
Available in Controller mode only
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v7.0 IMPROVEMENTS


Faster Save
 Note on the new Save process:
At project opening we now will decompress the project .pmx file into multiple files (.pmx, .pml,
.Playlist.pml, .DefaultLibrary.pml and .Composition.pml) those files will only be all visible in Windows
Explorer when the project is open in Pyramix. At save time we will re-zip those files into a single
.pmx file and at close we will remove those decompressed temporary files.



Jog Improvements
 Sound quality improvements
 Ballistic improvements
 Simplified settings/GUI layout
 Varispeed Audio Quality settings
 MassCore varispeed quality is automatically set according to the current Core load
 Native and Mykerinos varispeed quality is defined by the playback streams number set in the
played back tracks setting



Automation and Envelop Improvements (more to updates expected to come at Beta2)
 Trimming Automation on a Groups Faders will take in consideration the connected tracks (MT354)
 Mute is a logical "OR" of local or VCA master mute
 Isolate and Read mode behave as intended either locally on Grouped strips or on all slave Strips
when the master VCA is isolated (MT2157)
 Automation in Track header improvements in selection
 Ctrl + Automated control touch (mouse click) shows the automation track to the clicked parameter
 New Automation line colors
 Fader: Blue
 Pan/Balance/Surround: Green
 Send & On/Off: Cyan
 Mute: Red
 All others: Black Automation and Envelop editing improvements
 Automation and Envelopes now have a slight difference, Automation handles are little circles
and Envelopes handles remain as little squares.
 Mouse pointers have been change to ease grabbing of handles and points
 Editing Fine tuning with the use of the Shift modifier
 Follows the Nudge Settings
 Automation mouse editing behaves like the Envelop editing (MT3681).
•
Trim on the fly added (Ctrl modifier)
•
Write automation with mouse is activated with the Alt modifier (was Ctrl)
 New mouse pointers designs have been done for editing automation and envelopes
accordingly.
 There is now a difference between Automation and Envelope pointers, Automation cursors
have a little circle next to the pointer and Envelope pointers have a little square.
 There is now a difference in pointers when editing an already existing point and creating a
new point (clicking on a point or on the curve)



Editing Improvements
 Editing functions are now available in the Timeline dropdown menu (Mouse + Right click when a clip
is selected)
 Modes are bigger and easier to grab
 Shift + scroll wheel can be used to increase or decrease the track size of tracks (Like Alt does the
zoom and CTRL does the scroll left to right)



Media Manager improvements:
 QuickMount is not an option anymore with 7. It’s always used when mounting a folder.
 Added Media Manager Setting
 New option under Settings>Application>General to “Mount all Media Folders that were
mounted at previous Application Exit”
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When this Previously Mounted folders option is checked, the folders mounted in the media
manager are preserved: Next time Pyramix is launched, the Media Manager content is simply
updated against the file system folders to reflect potential changes.
With this option enabled it will be faster than a complete folders mount.
Arrow on the heading of the chosen column to show ascending/descending order
Lock Rename
 New option that will lock the renaming of the medias in the Media Manager or Libraries.
 To prevent the rename simply go under the Edit menu and select the “Lock Rename” option
Place Media:
 CTRL +P will do so when the focus is in the Tab section
Information: The media manager content doesn’t have to be fully remounted from scratch at every
application run anymore. That can be a big time saver when large amount of data is requested in the
media manager. The media manager content can be kept as is and its content integrity is
synchronized with the storage content every time Pyramix starts.
Therefore a new option group has been added (like for the On Project Opening): At Application
Loading:
 Mount the Folders listed in: All Settings > Application > Location Page > Permanently
Mounted Media Folders (like in 6.x)
 Mount all Media Folders that were mounted at previous Application Exit



Column Management improvement:
You can now perform a Mouse + Right Click on the headers of the columns to open the Columns menu



EDL Tab Improvements (MT1357)
 Media name column area can be extended
 Ability to sort it by any of the columns
 Retains the sorted order once clicking on column



Global Library Improvements
 Detailed indication load information status at load (MT2896)
 Global libraries are saved and restored.(MT3611)
 SHIFT+ Mouse Click will close ALL open libraries



Select Used Media:
 They are now single views (no more popping views group).
 The tree view displays all Media Manager folders containing selected Media.
The list view shows all media selected in the currently highlighted folder.
 Refresh(F5) toggles the list display between 2 modes:
 In the first mode, media is shown in media manager context with all neighbor media
displayed but grayed out. This neighbor media Category is set to “Not Selected”
 In the second mode, only selected Media is displayed.



Track Header
 Mini, Medium, Large, Extra Large Track Size menu have been added in the View > Tracks menu as
well to allow for mapping a keyboard shortcut
 Mini, Medium, Large, Extra Large Track Size Double Click now only works when clicking on the very
Left side of the Track Headers
 Track Header Automation menu now shows only the Bus | Control and not Mixer | Strip | Bus |
Control anymore
 Track Headers Button have been darken on GUI (Can be set to White under Timeline Layout Settings)
 Click in the Peak Meter to show/hide function return
 A third row has been added to the track headers
 Automation [+] to create a virtual track and display the automation (as in the Selected Automation
Display dialog)
 Fx button added in the second row in Track Header
 Monitoring: We now toggle between Repro and Input only, this only in Play. In Stop we toggle
between Auto, Repro and Input.
 New keyboard shortcuts access for Track Headers buttons:
This affects the currently selected track.
 Mute
 Solo
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Monitor
Record Ready
Display (Wave/Envelope)
Automation Show/Hide
Automation Sub-Tracks (see Automation new feature description above)
And all Automation commands accessible through the right mouse button on the [A] button



Toolbars improvements
 Toolbars buttons now have a background when applicable.
 Main TimeCode can now be edited
 Counters Toolbar switches to "very flat" mode when only the main counters are displayed
 M IN and M OUT are now colored in Red/Green



Counters can now follow the Nudge settings (MT3725)
 Pressing the +- signs on Mark In and Out counters using Ctrl + Alt will follow the current selected
Nudge Setting.
 The same applies for the rest of the counters



Markers Improvements (MT3684)
 Markers can now be deleted and renamed from top of the timeline
 Left or right click on the Track Header top track group portion will open a jump to marker Dropdown
menu.
 Makers are also available from the Markers dropdown menu at top to Track Header



New Synchronized Tracks & Strips Behavior
When Creating, Destroying or Moving Strips in the Mixer Configuration page (or right mouse button) the
connected Tracks are also Created/Destroyed or moved accordingly
 Will apply when the menu Tracks > Synchronize Tracks & Strips is checked.
 On Create or Move the Tracks are created or moved seamlessly.
 On Destroy, only empty tracks are destroyed. Tracks containing clips are preserved, disconnected
and set to minimum size.
 Only applies when the menu Tracks > Synchronize Tracks & Strips is checked
 When in Synchronize Tracks & Strips, moving a Fader first attempts to select tracks in the selected
track group if any, then defaults to selecting the first track connected to the strip as of now.
 When in Synchronize Tracks & Strips, renaming a track doesn’t rename all tracks connected to the
same strip, but only those in the same track group



New Timeline Layout options in Settings:
 Track Header option in the Timeline Layout Settings offering the choice for Back buttons or White
buttons
 Choice of disabling Gradient Look for Clips
 Choice of color for:
 Waveform of Muted Clips
 Waveform of Phase Inverted Clips
 Waveform of Wrong Sampling Rate Clips
 Sync Point
 Timeline Displayed options
 Choice of graying Out Muted Clips
 Choice of displaying a Phase Invert sign in Clips
 Choice of displaying a Wrong Sampling Rate sign in Clips
 Choice of always displaying the Sync Point or only when the Clip is selected
 Choice of displaying the Sync Point Color only when Sync Point is set or always
 Choice of displaying Envelope/Automation Curves as Thick line on large track size or always
thin
 SRC indicator
 A little “SR” icon in Blue means that the media clip is at “Wrong SR but SRCized” (the SRC
option is enabled in the Settings>Application>Playback/Record)
 A little “SR” icon in Red means that the media clip is at “Wrong SR but NOT SRCized” (the
SRC option is disabled in the Settings>Application>Playback/Record)
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CD/SACD Tab layout
 CD Tree Info and PQ Markers we inverted in the Layout to show Tracks on top of Tab



Waveforms
 Half Waveforms display (MT1228):
 New option under menu View>waveform display>Show Half Waveform / Origin
 Allows users to display the waveform relative to the bottom of the clip (useful for mixing)
 Clips menu entry: Added Keyboard shortcuts for Background and Waveform Colors



Monitor Panel
The Monitoring Panel is now available from the Monitor Menu. Shortcuts can easily be assigned to each
parameter for control.



Interchange Improvements
 The AAF import now includes a new option “Use UTF-8 conversion to import Links/Locators Path
Names”. This allows converting the referenced path names (called Locators in AAF/OMF) using UTF-8
coding. This was the default previously and works in most cases, but we leave the option for some
imports that could be problematic without.
 We now export Copies to a "Audio Files" folder instead of a “Media Files” folder
 Clips names in timeline or some DAW (ProTools) are note the "clips names" of the Pyramix Timeline
but the master clip name. We have resolved this but it implies a larger files generated if multiple clips
with different names share the same media
 Fade in/out were linear
 Supports only Power and Linear fades (AAF limitation)
 Now correctly when re-importing in Pyramix but seems having no effect on some other DAW



Source Destination
 Three new menus have been added in Edit > Source-Destination:
 Automation Unchanged for Source Track Groups
 Automation Off for Source Track Groups (this mode will also affects the Enable
Cut/Copy/Paste Automation mode (set to Off for Source Tracks)
 Automation Play for Source Track Groups (this mode will also affects the Enable
Cut/Copy/Paste Automation mode (set to Off for Source Tracks)



FLAC decoding (MT3631)
 Decoded with the DS Handler (bit transparent).
 Install the latest Flac distribution in Program Files/FLAC see download link below
http://sourceforge.net/projects/flac/files/flac-win/flac-1.2.1-win/flac-1.2.1b.exe/download
 Pyramix will use this distribution to decompress all .flac files



Third Party ReNOVAtor:
 A new ReNOVAtor Renderer version (2.2.1.1615) from the Algorithmix team that fixes a memory
issue for a given selection is now available.
 When lacking memory ReNOVAtor should now come up with an “Out of Memory in ReNOVAtor,
selection too long” error instead of Crashing. You will then have to make a smaller selection in order
to perform such a Render.
 For installation, make sure that Pyramix is closed and simply run the installer corresponding to the
dongle you use (this will replace the previous version).
 http://intern.algorithmix.com/download/reNOVAtorPyr_Wibu.exe
 http://intern.algorithmix.com/download/reNOVAtorPyr_Sync.exe



DMA overload
 We now indicate in the Core section (bottom of Pyramix GUI) if a DMA overload occurred. The text in
such case will be a blinking red DMA indication



DolbyE Encoding/Decoding (option)
 New SurCode Dolby E Decoder and Encoder VST keys. No longer need for Minnetonka & iLok
 Dolby E can be authorized through a Merging VST Key
 Users will need first launch VST scanner and scan the folder path below
”C:\Program Files\Steinberg\VSTPlugins\Merging Technologies” in order for the SurCode Dolby E
Decoder and Encoder VSTs to be available.
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BUGS FIXED Pyramix v7.0 Release






























Fixed. Sqlite (database) optimization
MT3793: AAF: Relink problems with special characters ("Use UTF-8 conversion to import Links/Locators
Path Names" button in import AAF window)
MT3958: Fixed. Media Manager: PMX or PML files located in the same folder than Medias will not
quickmount and reparses all medias at project opening
MT3999: Fixed. Media Level indication not accurate in some selections
MT3984: Fixed. Final Check mini panel in setup page takes too long to update
MT3993: Fixed. Media Manager: Some folders are seen in double or triple
MT3980: Fixed. Some libraries become corrupted with "Parameters incorrect" message
MT3994: Fixed. Generated CD Image may not be aligned to CD frames boundaries and cause Glitch at end
of resulting file
MT3957: Fixed. Database: Added Media Manager menu (Media Folder) entry to clear Media Manager
history
MT3974: Fixed. Database: Media_Library.pml becomes corrupted if changing the Database Location and
not restarting Pyramix
MT3981: Fixed. Final Check Surround monitor and oscillo background alignment problem
MT3995: Fixed. Generate CD Image with Mixer dither in a non 44k SR project will crash at the end
MT3996: Fixed. Some OMF (pure) files not seen in media Manager
MT3971: Fixed. Final Check loudness "PAUSE" button doesn't pause Int and LRA
MT3972: Fixed. FCM VU meter peak hold not functional
MT3976: Fixed. Mouse erasing automation point in the Timeline does not behave correctly on extra tracks
MT3963: Fixed. Automation: Track Bus with No Automation in view will not take parameters in Snapshot
window
MT3962: Fixed. Automation: Snapshot parameters incoherent
MT3661: Fixed. Automation drift when generating CD image
MT3881: Fixed. Jog Wheel Selection Listen not considering only selection
MT3873: Fixed. Automation: Add shortcut option for snapshot, in automation menu
MT3914: Fixed. Rename in Media Manager not working
MT3929: Fixed. Library: update library reference Path is not working
MT3937: Fixed. Mixer: Configure page, copy to selected Bus does not work in some cases.
MT3938: Fixed. MTUSBSync: NTSC detection not working, reporting PAL
MT3949: Fixed. Global Library: media icons are not reflecting the mounted/unmounted info. need to F5
refresh to get an up-to-date display
MT3956: Fixed. Mixer Jumps to the side of the screen when scrolling
MT3966: Fixed. Final Check Overload leds behaving weird
MT3967: Fixed. Added Loudness Range in Final Check

BUGS FIXED Pyramix v7.0 RC3


















(some fixed bugs could be missing from the list)

MT3811:
MT3819:
MT3820:
MT3822:
MT3832:
MT3834:
MT3887:
MT3911:
MT3913:
MT3918:
MT3920:
MT3822:
MT3923:
MT3925:
MT3930:
MT3934:
MT3935:

Fixed.
Fixed.
Fixed.
Fixed.
Fixed.
Fixed.
Fixed.
Fixed.
Fixed.
Fixed.
Fixed.
Fixed.
Fixed.
Fixed.
Fixed.
Fixed.
Fixed.

(some fixed bugs could be missing from the list)

Tempo and Signature are not communicated through Rewire
Media Manager: Lock rename not always working
Media Manager: Dragging media from Trimmer to Libraries not always working.
Pyramix does not exit when Rewire is enabled
Media Manager: impossible to delete a clip that is referenced in the timeline.
Libraries: Place function not working if the Trimmer is set to OFF
Automation: Encountered Improper Argument at Automation paste
Pyramix may crash when accessing ASIO4ALL properties
DMA load now indicated in the Core section if an overload occurred
Playback offset (-1 frame) when a playback is preceded by a varispeed phase
Trimmer: Keeps last clip viewed in display, even if changing folder focus
Mixer Routing IB are missing
Trimmer: If off, the played audio clips will not update
Crash when opening some projects timeline
Media Manager: Runtime Error (or Crash) Reversing some clips
MTUSBSync: wrong video format detection in driver version 1.0.13
MTUSBSync: Timecode does unlock when synchronized to video signal 1080sf @24 frm/s
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MT3885: Fixed/improved: Reconform Load Change EDL consumes too much memory. Improvements to
release some memory.
MT3905: Fixed. Improved the Search DropDown menu box. As toolbar buttons on the left of the search
box and in a Search Menu in the Library, Media Manager and Search Results frames.

BUGS FIXED Pyramix v7.0 RC2



























MT3888: Fixed. Media Manager: Clicking in Media Browser folder (media) will mount it automatically
MT3886: Fixed. Media Manager: Medias become offline if selecting same media folder in Media Browser
MT3882: Fixed. VCA group Automation will position all faders at 0dB at first playback
MT3877: Fixed. Ctrl + Automated control touch (mouse click) shows the automation track
MT3869: Fixed. AES31 import : audio files not in the timeline.
MT3063: Fixed. Libraries: Cannot drag&drop clips with in/out from the trimmer to the timeline, or crash
MT2378: Fixed. Automation "A" parameter selection should be more efficient, better auto selection of the
latest automation parameter touched.
MT1370: Fixed. Track Monitoring mode: Need a choice rather than having to cycle through the three
possibilities (ALL INPUT / AUTO INPUT / REPRO)
MT3824: Fixed. Media Manager: Cannot copy/paste multiple medias selected anymore
MT3828: Fixed. Libraries name sorting not logical
MT3856: Fixed. Offline Libraries should keep folder tree hierarchy
MT3860: Fixed. Crash when opening some project - Loading Media file
MT3864: Fixed. ASSERT when opening the specified pmx in 6.x to 7
MT3868: Fixed. Media Manager; Pyramix will crash if .mtk file is present or .adl
MT3871: Fixed. Save switches the focus away from timeline
MT3866: Fixed. VST plugins automation mode is not settable from the Pyramix mixer
MT2117: Fixed. Automation cut copy paste should cut the automation away if cut is used on the clip
MT1592: Fixed. Automation: auto-display not working on surround panner Front/Rear
MT3859: Fixed. Pyramix editing CrossFade between clips improper argument message still possible
MT3865: Fixed. Mixer automation mode is not updated when set from a console
MT3870: Fixed. Automation: Is lost with Automation Reconform EDL
MT3878: Fixed. Sony over IP: Ability to enter an IP address instead of a computer name
MT3825: Fixed. Automation: Auto-Display update not always considered if going from one parameter to
the other
MT3872: Fixed. Clip Gain requires mouse click as "Enter" focus not working.
MT3862: Fixed. Unable to copy paste VST plugins automation from a track to another
Media Manager: File extension are now parsed according to the ones supported by the media handlers
within Pyramix.

BUGS FIXED Pyramix v7.0 RC1















(some fixed bugs could be missing from the list)

(some fixed bugs could be missing from the list)

MT2669: Fixed. Monitor Panel: should have shortcuts to parameters changes parameters in the Monitor
section
MT3857: Fixed. Track Tab: Cannot create new track.
MT3760: Fixed. Template: Open or Save as template cannot be re-opened afterward
MT2641: Fixed. Request for default pan placement for SR busses on mono or stereo channels
MT3672: Fixed. AAF improvements
MT3712: Fixed. Mixer: Cannot insert a VS3 plug-in from the configure page on a Direct Monitoring strip
MT3312: Fixed. DSD Project - Mixer- "Organize" should be deactivated ("Organize" tab should be removed
in DSD project because user can load incompatible mixer)
MT3854: Fixed. crash when double click outside of tracks in timeline
MT3676: Fixed. AAF import crash when importing from network
MT3823: Fixed. Playback stall when SRC is enabled (in DXD project with DSD medias & 48kHz project
playing 44.1kHz medias)
MT3747: Fixed. Cannot access Mixer settings from Mixer page (Mouse+Right Click menu)
MT1020: Fixed. Automation: Modifier key to turn the pen into an eraser
MT2153: Fixed. Automation" The "Automation overlay context menu" (Displayed automation track) should
be available in the keyboard shortcut editors with search options also
MT2213: Fixed. Automation: Adding a Node / Point will raise the +db level instead of keeping it at 0 db
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MT2884: Fixed. Automation: No longer possible to do a snapshot with write to end option
MT3658: Fixed. Record: Name not displayed during recording if "Fixed Cursor" is enabled
MT3662: Fixed. Track header automation functions not undoable with VCA tracks
MT3689: Fixed. Automation Snapshot: Add old behavior option back of selecting all
MT3713: Fixed. Selection: Adding to selection does not update the Ruler Selection Duration length value
MT3801: Fixed. Fade Editor: faders are not always displayed correctly
MT3806: Fixed. Templates: Cannot open some templates.
MT3830: Fixed. Mixer: When minimized the Meters are displayed in black (windows 7 only)
MT3717: Fixed. CD/SACD tab layout should display part of the CD Album & PQ Markers
MT3150: Fixed. Mixer: Added contextual Menu option to set all Effects to Enable
MT3602: Fixed. Mixer: Delay Compensation indicator not accurate in Automation playback
MT3503: Fixed. Track header i/o list includes the Physical i/o name
MT3840: Fixed. Read-only problems for QuickMount and .pmx/pmt
MT3858: Fixed. Problems with project name containing dot(s)
Fixed. VST GUI Display: make sure a VST Editor UI is always visible when showing it
Fixed. New Templates were included in V7.0RC1
Fixed. Import DDP issue
Fixed. AAF timestamps are now correctly imported/extracted

BUGS FIXED Pyramix v7.0 Beta4
















MT3792: Fixed. Media Manager: Sort by creation date by clicking the column header is not accurate.
 In order to apply such fix the user must
 Mounted folders need to be remounted from scratch (SHIFT+Refresh) so creation date is
regenerated.
 For libraries they need to be regenerated either from 6.xxx versions or from sources.
MT3736: Fixed. Clips played in libraries or drag and dropped in timeline do not show online icon
afterwards
MT3796: Fixed. Media Manager: Paste timeline clip in Media Manager browsed folder changes the original
clip path location (Temporary mounted folders in Media Browser should be unmounted when unselected)
MT3799: Fixed. Media Manager: Error-Encountered an Improper Argument in non Detail View
MT3741: Fixed. Project Media Folder: ignored when already set and present
MT3724: Fixed. Column settings view options sometimes comes up empty
MT3798: Fixed. Waveforms disappear if clip fade is length of clip
MT3759: Fixed. Relink issue when importing AAF
MT3740: Fixed. Timeline/Media Manager: using copy in timeline and paste with media in Media Manager
bring along a composition file
MT3519: Fixed. Pyramix: Media Manager "Improper argument" error.
MT3800: Fixed. Half Waveforms display not accurate at times
MT3746: Fixed. Search: Keep a history of the search results.
MT3677: Fixed. Isis record button does not lit in Auto-Punch mode
MT3803: Fixed. Generate CD image will crash Pyramix (MTSRC_hepta.dll)

BUGS FIXED Pyramix v7.0 Beta3












(some fixed bugs could be missing from the list)

(some fixed bugs could be missing from the list)

MT3660: Fixed. Recorded clips do not appear in Media Manager, unless doing a refresh.
MT3791: Fixed. Pyramix Record: Long Pause after multitrack recording one file per track with v7.0
MT3797: Fixed. Automation and Envelop points on same vertical alignment cannot be moved nor selected
MT1353: Fixed. Pyramix CD Scale mismatch, and not representative
MT3789: Fixed. Timeline: Clip editing & Crossfade can make clip go under others visually in timeline.
MT3782: Fixed. Create one new Strip & Track will duplicate the tracks in timeline
MT3779: Fixed. Metronome: the individual levels for Bars, Beats and Grid are not working
MT3756: Fixed. Synchronization Sony unstable in chase
MT3771: Fixed. Bars & Beat Region link will affect the Tabs Dropdown menus (quickly closing them)
MT3755: Fixed. Quickmount are too slow at load in PMX v7.0. Next Mount attempts should be much faster
if nothing has change in the mounted folder. Otherwise, Mount occurs again.
MT3784: Fixed. Create offline library: broken
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MT3750: Fixed. Global Libraries: Save as does not put the file extension .pml and neither renames
correctly
MT3749: Fixed. Document library: Save As crashes Pyramix
MT3734: Fixed. Saving to new template will not allow you to re-open the template afterwards
MT3733: Fixed. Media Manager: Trimmer play blocked causing crash in copy media afterwards
MT3237: Fixed. Select used Media comes up empty
MT3714: Fixed. Add Phase information on the clip in timeline (added in Settings>Timeline Layout)
MT3705: Fixed. Mounted Folder inconsistencies. The folders are displayed in light grey when they're
empty.
MT3721: Fixed. Final Check: parameters should be saved in project.
MT3761: Fixed. Cannot open a v6.x project that has been saved under V7.0
MT3760: Fixed. Fail to open document: Save as template cannot be re-opened with new from template
MT3744: Fixed. Timeline: some editing functions will something make clips disappear in the timeline
MT3768: Obsolete. Remove ViperNL controller protocol
MT3544: Fixed. Sync Marker should be optional in timeline view (CrossFade also)
MT3677: Fixed. Isis record button does not lit in AutoPunch mode
MT825: Fixed. Zoom Vertical not working after a Zoom horizontal, as you are re-directed to the Project
menu when using ALT

BUGS FIXED Pyramix v7.0 Beta2






MT3671: Fixed. Crash when mounting some Aiff files coming from Avid
MT3735: Fixed. Open a library in Pyramix v7.0 and the name will be New Library
MT2946: Fixed. Pyramix DDP import module: longer output path field (for longer path name)
MT3742: Fixed. Replace VS3 plug-in on bus
And many changes to GUI according to Beta Users feedback.

BUGS FIXED Pyramix v7.0 Beta 1























MT3580: Fixed. Global Library: Crash when using search
MT3581: Fixed. Archive: Cannot consolidate archive (Pyramix v7.0)
MT3637: Fixed. Media Manager: Place in timeline will only place one clip
MT3703: Fixed. Paste: when pasting to a destination folder, pasted media must be selected by default.
MT3696: Fixed. Libraries: Can't open several libraries at once
MT3699: Fixed. Select mounted folder combo box doesn't work
MT3700: Fixed. Select used media is broken
MT3692: Fixed. Document libraries: Adding a composition entry to the library – can’t paste
MT3707: Fixed. Playback: Cursor Auto-Return no longer works (pmx v7)
MT3697: Fixed. Libraries: Can't open library / Mount folder containing
MT3579: Fixed. AAF import fails "Unhandled Exception' (Pyramix v7.0)
MT3679: Fixed. Native with Lynx Aes card : ASIO latencies changed message (moved to Log file)
MT3501: Fixed. Jog wheel Zoom mode improvements (Zoom to Navigate issue is present only in fixed
cursor mode)
MT2922: Fixed. Library: Cannot cancel the opening of a global library
MT2940: Fixed. Media Manager: Selecting a folder make it jump to the bottom of the folder tree
MT3357: Fixed. Pyramix freeze when mounting special file extensions (.sys, .odt, .txt, .part, .vip)
MT3556: Fixed. Several MassCore entries in BCD (Windows OS multi-boot)
MT3625: Fixed. Save Document library will select project name with pmx extension instead of .pml
MT3670: Fixed. Mykerinos: One channel of the AES2-SRC was spread over two channels when using the
special SRC mode 8FS to nFS
MT3584: Fixed. Conversion error of v6.x quickmounts to the new v7 quickmounts (SQLite version)
MT3321: Fixed. Library "Out Of date" message appearing with new project and libraries.
MT2894: Fixed. Libraries: GUI improvements (view list, edl, trimmer display)
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Pyramix V7.0 (SP2) Known Issues
(Some issues could be missing from this list)



MassCore













Now supported under Windows 7 (32 Bit only) since Pyramix v7.0. Note that Pyramix is not
supported under 64bit OS.
Users upgrading from Vista or XP to Windows 7 must uninstall RTX Interval Zero Runtime prior to
upgrading (from Windows Add or Remove Programs). Merging recommends that you proceed with
a fresh OS install rather than Upgrade. See installation procedure at beginning of Release Notes.
Hyperthreading is supported for MultiCore processors only, since Pyramix V6.1, but Merging
recommends that you disable the Hyperthreading for the moment.
We recommend that you do not use more than 65-70% of the Core resources, to avoid intense
graphic refresh burst related problems. Three safe core zones have been set. Eventually this will
be optimized further.
•
0% to 65% Green zone (best performance)
•
65% to 75% Orange zone (moderate risk)
•
75% to100% Red zone (performance could be at risk if major screen redraws are initiated
by the user).
If the Core indicator blinks (red), this will indicate a drop, only be concerned if the drop occurred
during Playback/Mix down or record. To reset the Core drop simply do a Mouse click on the Core
indicator, for more information please refer to the appropriate section in the User Manual. VST
plug-ins users should consult the VST Core Load information also available in the User Manual.
External Insert plug-ins: The same input and output cannot be used in the External Insert plug-in
and the Mixer at the same time, they are exclusive to either one.
MassCore: Core indicator will show a peak/overload after a save on large project or when
rebuilding the Mixer (project open-close). Known as issue MT3113.
Since MassCore is a Realtime engine users should mainly be concerned if the core peak shows up
during realtime events (Play, Record, and Mixdown). To reset a Core peak simply click on the Core
indicator.
The MADI 1 daughterboard is not supported in multi-board, neither in Mykerinos nor MassCore.

General Known Issues


Windows XP user: Windows XP-SP3 must be installed in order to install Pyramix v7.0.



With the Release of version 7.0, new Pyramix systems will only be available in either Native or
MassCore versions. Mykerinos Technology will continue to be used as I/O, but the DSP mixing
power on the cards officially becomes legacy technology. It has been a good run for the Tri-Media
Chips, whose life span has by now extended over more than 11 years, but it is time that we put
them out to pasture. This doesn’t mean that your Mykerinos Based systems will become obsolete
as you can upgrade any Mykerinos system to MassCore without having to do anything but
purchase a MassCore License *. And if you aren’t still sure that you want/need to upgrade, then
the Mykerinos based DSP will still happily work in Version 7 on an “as is” basis.
* please consult the recommended minimum PC requirements for MassCore at
http://www.merging.com/pages/pcconfig



Pyramix 7.0 projects are NOT compatible with the previous Pyramix Releases. In order to open
such projects in an older Pyramix version please make sure that you perform the proper Save
Special option. A Save Special “Save as Version 6.2” was added to the list.
Warning: v7.0 Libraries format are not compatible with the previous Pyramix release. Save as
previous version format will not be possible. A back up of the libraries .pml.6xx file should be
available and can be renamed as .pml in order to be opened in an older Pyramix version (but will
not take in considerations the modifications made to the libraries under the use of Pyramix v7).



Pyramix Native: The Direct Sound mode is no longer supported. We recommend to instead
download and install the Asio4All driver (http://www.asio4all.com/)
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The Virtual Tracks were removed from Pyramix 7.0. It is no longer possible for users to create
them. Note that they are still supported when coming from older projects. As a replacement we
recommend the use of the Automation Sub-Tracks from now on.



Libraries: Search Results created with the 7.0SP1 version have been corrupted due to an internal
bug. You need to purge all search results created with version SP1 either by completely deleting
the Search_Results_.pml file OR by deleting the corresponding folders in the search result view



Changing project sampling rate 1FS/DSD/DXD within the same Pyramix session can at times
cause problems (Mixer stuck at wrong sampling rate). Workaround: launch back Pyramix.



Final Check Metering: When running MassCore on more than one core, it is possible (though not
always the case) that Final Check cannot monitor certain bus/stem (No metering, but it works
again when selecting another bus)
•
Workaround 1: Do not use final check with more than one core.
•
Workaround 2: Add an effect (any effect will do, but you may prefer to pick one that
doesn’t modify the sound: phase oscillo, surround monitor…) on the bus that final
check doesn’t want to monitor.



Low Memory Condition Warning:
A warning informs users when the system is reaching Low Memory Conditions. In order to
save a project under such conditions Pyramix will switch to Save to Disk mode as not enough
memory might be available otherwise. This warning was added in order to prevent a Runtime
Error on Save.
Note that the Save time in Save to Disk mode in Low Memory Condition might take a longer
time since the memory is being dumped to disk in order to allow the users to save their
projects. We recommend afterwards to exit and restart Pyramix in order to free all memory.
This Low Memory warning threshold can be adjusted by the user if one wishes it to come
earlier or later. With every systems and workflows being different, Merging leave you the
ability to adjust when the Warning will show up.
Procedure:
•
Close Pyramix
•
Type regedt32 in the run command
•
In the registry go to HKEY_CURRENT_USER\Software\Merging
Technologies\Pyramix\Settings\Save to disk threshold (this key will only appear if at
least one save was made using that version)
•
Default value in Decimal mode has been set to 15
- The higher the value is set, the earlier the Low Memory warning will come
- The lower the value is set, the riskier it is for you to encounter a Runtime Error at
save (previous Pyramix versions value would have had this value set to 0)
Merging with this Pyramix v7.0 version has significantly reduced the memory consumption of
Pyramix when confronted with the task of loading enormous libraries. For the long term, the
move of our applications to a 64 bit operating system will provide a very solid platform to
accommodate the ever growing project size requirements of some of our users.



MT0-USBSync install problems: Use the latest driver in Merging’s Support Download section.



Cannot use DiscWrite with Pyramix:
Workaround: Re-install Pyramix (maybe run clean up after un-installing Pyramix) or Re-install the
Gear driver. Prior to re-installing such drivers use the Gear Removal Utility below.
Gear Removal Utility:
http://www.gearsoftware.com/downloads.php?dir=updates/windows/drivers/&file=Driver_Remover.exe

Find other Gear links that may be useful to determine if the drivers are installed and functioning
correctly and other tips: Gear Driver Status:
http://www.gearsoftware.com/wiki/index.php?title=Determining_if_GEARAspi_drivers_are_installed_correctly

Gear Known Issues:
http://www.gearsoftware.com/rss/GEAR-drivers-feed.php
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Various Known Issues

















StripTools and BusTools GUI might be corrupted in display on the 1st one in line, under Windows
7. (MT3785). Workaround: Rebuilding the Mixer should refresh the effects accordingly
Record: A small pause can occur after the first recording of a session. (MT3827)
Timeline and Realtime Sampling Rate Conversion: clicks may occur when doing playback or
mixdown in a region where 2 overlapping clips reference the same media with different sampling
rate than project.
Workaround: Convert those Medias to the project's sampling rate, prior to using such a workflow
MT Asio Bridge not working with some third party applications (e.g. Reason) (MT3596)
StripTools: not always opened from "Fx" track Header. (MT3764)
Workaround: Scroll through the StripTools display once
Recording: Red recording block can disappears during recording on some configuration.
Note: The media will not be affected by this display problem. (MT3577)
Virtual Transport: VT missing Icons for DSplayer and Midi Sync clients. (MT3480)
GPI/O need more time to receive command – less responsive (MT3593)
Workaround a previous dll version can be used, contact support@merging.com
Ogg files with SRC on can make Pyramix crash under Windows XP (MT3569)
Workaround: disable Real Time Sampling Rate Conversion
(Settings>Application>Playback/Record) or convert file
ADR keyboard is by default disabled. To enable it you must download and run the proper Registry
Key. http://download.merging.com/beta/AssociatedTools/ADRKeyboard.zip
Multiple projects opened simultaneously: We do not recommend users to have more than 8
project opened at the same time (due to GDI object limitation).
Waveforms: Since Pyramix V6.1 the new waveform file format is PK2, such a PK2 waveform file
cannot be read in previous Pyramix version and in such a case waveforms will have to be regenerated. On the other side previous waveforms format PK files (Pyramix V6.0 and older) are
compatible with Pyramix V6.1 & V6.2 & V7.0.
The Render Tool will create a temp file for the CEDAR and Nova v0.99 in C:\ Be aware that
Merging cannot change the Temp file patch of such third party Render.
Interchange: AAF non-embedded export to Pro Tools 7x could generate « Could not complete your
request because an unexpected error happened while trying to find an audio media file’s format”
error. We recommend to use AAF Embedded when exporting to ProTools 7. ProTools 8 is known to
be working in such case.



Third Party Plug-ins
 Algorithmix ReNOVAtor for Pyramix: We recommend users to download the latest version available
on their site. www.algorithmix.com
 Cedar: Install issue on certain Vista configurations where you might not see the Cedar plug-ins
after the installation process. The problem is due to erroneous referencing of the license manager
utility on a vista machine. Please contact Merging Support or Cedar Support for all details and
workaround.
 Cedar: Some toolbar icons might be missing if on a Windows XP system. Workaround: Disable the
Skin option in Pyramix>settings>Desktop Layout.
 Altiverb: We recommend users to download the latest version available on the Audio Ease site.
 UAD2: Certified as working with Pyramix, see forum known issues
http://forum.merging.com/viewtopic.php?f=26&t=6798



MP3, AC3 Files and other compressed formats support:
 Default Windows installation should handle most of the common compressed file formats. In case
of problem with the default Widows Installation, Merging has a list of recommended third-party
codecs but will not certify any codecs. http://forum.merging.com/viewtopic.php?f=18&t=5755
 Vista users warning: UAC (User Account Control) can be blocking the “Essentials Codec Pack” at
startup. If this is the case, you should see once logged into your session at the windows bottom
bar a “Windows has blocked some programs” message. You can then unblock it from there or
deactivate UAC from the Windows Control Panel.
 Install the latest Flac distribution certified in Program Files/FLAC, see download link below
http://sourceforge.net/projects/flac/files/flac-win/flac-1.2.1-win/flac-1.2.1b.exe/download
Pyramix will use this distribution to decompress all .flac files
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Pyramix v7.0 Tips
Pyramix v7.0 Media Manager and Library recommendations and changed behaviors
 The Database Location path is set under Settings>Application>Location>Default Database Location.
Otherwise the database path will be C:\Documents and Settings\<User Name>\Application
Data\Merging Technologies\Pyramix
 For better performance Merging strongly recommends that you move the Database location on your
fastest system Drive. SATA2 - 7200 rpm Disks are recommended and not necessarily C:\OS default
drive (as a drive with less activity and more speed should be performing better)
 Save:
 V7.0 will speed up your Save times if Saves are done on a performing Disk (e.g. SATA2 7200
rpm). Saving on old Disks (e.g. IDE) or if saving on the OS Disk itself (often very busy with
other tasks) could slowdown your Saves times.
 A registry is available to get back to v6.2 Saving mode. This will actually dictate whether or
not the libraries are saved in 7.0 format (applies only to the .pml within the .pmx).
1. Launch regedt32 from Windows “Run”
2. Go to HKEY_CURRENT_USER\Software\Merging Technologies\Pyramix\Libraries
3. Create a DWord (32bit) Key and name it SavePMXLibrariesAsDBLibrary
4. If Key value is set to 1 or not present: will actually apply the actual 7.0 Save
5. If Key value is set to 0: libraries in the 7.0 PMX (.pml only) are saved in v6.2
mode
 However, you must be aware of the following drawbacks in v6.2 mode:
•
When opening the “modified”-style pmx, the pml embedded will be reconverted. This
can lead to some extra time spend within opening.
•
Depending on your project type and size, “modified”-style save can become slower
that “standard”-style v7 save.
 Merging recommends that your Disk have the indexing disabled and that you make sure that the
Power Management is set accordingly for better performance.
 Disable File Indexing (XP + Vista + 7):
1. Open “My computer”
2. Right click on each drive and select “Properties” from dropdown menu
3. Un-Check the indexing check box
 Verify the Power Management:
Go under Windows Control Panel and open Power options
•
XP Users: Set “Power Scheme” to “Always On” and set Turn off Hard disks to “Never”
and System Standby to “Never”
•
MassCore users Under Vista & 7: Power plan should be “RTX – recommended”
•
Native Users: Make sure you select the “High Performance” power plan
 For ultimate performance Merging recommends that you (not mandatory)
 Set your Antivirus to off while running Pyramix
 Set Windows Automatic-Update to “notify me”
 Avoid active internet connection while running Pyramix
 Keeping Mounted Folders when closing and restarting Pyramix can speed up your workflow: Set
option under All Settings>Application>General> “Mount all Media folders that were Mounted at
previous Application Exit”
 You can clear the History of the Media Manager under the Media Manager>Media Folder menu
 Merging recommends Pyramix users save their project on a Disk were no OS resides for better
performances (C:\ not recommended).
 Since Pyramix 7, the Composition Library is not longer present. We’ve made the decision to do so to
preserve editing interactivity.
We recommend 2 workflows to workaround this:
 A) Toggle the Select Used Media view to list the media by location, based on timeline
selection. You can search and drag & drop from this window back into the timeline. You can
also save the Select Used Media content to a Library that can be re-opened as a library.
 B) Use the EDL view since it has been improved in Pyramix 7 and it should be functional and
reliable.
 Default library: The default library should be present but will be empty by default, until you add
something to it
 Global Libraries – Default Library: The global library should appear empty by default. If there’s a
Default Library in it, it could come from the last closed session.
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